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Dear customer,

Thank you for choosing Anycubic products.

Maybe you are familiar with 3D printing technology or have purchased
Anycubic printers before. However, we still highly recommend you read this

manual carefully, as the installation techniques and precautions can help you
avoid any unnecessary damage or frustration.

Please visit https://support.anycubic.com to contact us if you have any

questions. You can also learn more information from the website, such as

software, videos, models.

Anycubic support center

Copyrighted by “Shenzhen Anycubic Technology Co., Ltd ", all rights reserved.

Team Anycubic


https://support.anycubic.com/

Safety Instructions

Always follow the safety instructions during assembly and usage, to avoid
unnecessary damage to the 3D printer or individual injury.
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Please contact our Customer Service if you have any issues after
receving the products.

In case of emergency, please immediately cut off the power of the
3D printer and contact our technical support.

UV light is harmful to the eyes; please avoid direct contact. When
operating, wear protective equipment such as anti-UV goggles and
gloves.

Anycubic 3D printer includes components that can cause injury.

When the Temperature control resin vat heats up for a long time,
its surface temperature becomes high. Avoid touching the resin vat
without protection after heating.

Be cautious when using the scraper, and make sure to orient the
sharp parts of machine and tool away from people.

Keep the Anycubic 3D printer and its accessories out of the reach of
children.

Vapors or fumes may be irritating at operating temperatures.
Always use the Anycubic 3D printer in an open and well ventilated
area.

Do not expose Anycubic 3D printer to any water or rain
environment.

Use Anycubic 3D printer in an environment with a temperature of
5°C-40°C and a humidity of 20%-80%. For optimal performance, do
not exceed this range. Also, avoid direct sunlight exposure.

Do not disassemble Anycubic 3D printer, please contact technical
support if you have any questions.
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Product Overview

All pictures are for reference only. Please comply with the actual products.
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Product Overview

Auto-fill Unit

- Resin Pipe and Air Pipe

2,
Tt

Indicators* ~

Cap Part

Resin Input/ Output

Cap Part Wire

__________________________________________________________________

[

. *Indicators: Green light indicates the connection of the main module.

|

| Red light indicates that the resin in the bottle is insufficient.

N —————

__________________________________________________________________



In the Box

ANYCURBIC
- 5
L]
——
Photon Mono Print platform * 1 Resin vat* 1 WiFi antenna
M7 Pro
117 >
=
Hex key set Protective equipment Funnel*5 Scraper * 2
ATIRIAE
Screen protector kit Leveling paper Manual * 1 USB drive * 1

Auto-fill unit Power cord



Technical Specification

Operating System
System Photon Mono M7 Pro
Software Anycubic Photon Workshop
(also compatible with other software)

Connectivity USB Drive, WIFI

Specifications

LCD screen 10.1 inch 14K
Light source COB light

XY Resolution 13312 *5120

Z axis Accuracy 0.01T mm
Suggested Layer Thickness 0.01~0.15mm

Physical Dimensions

Dimension 310 mm(L) *315 mm(W) *520 mm(H)

Build volume 223.64 mm(L) *126.48 mm(W) *230 mm(H)
Weight 12.8 kg

WiFi

Frequency Range 2.4 G (2.400~2.4835 GHz)

Work Mode AP, STA, AP+STA mode



Recommended Print Parameters

@ Default @ Default ® High Speed
Parameters Group Resin_Normal Resin_Fast Resin
Layer Thickness 0.05 mm 0.1 mm 0.1 mm
Normal' Exposure 1.8s 2.2s 1.45s
Time
Off Time 0.5s
Bottom.Exposure 25 < 25 < 155
Time
Bottom Layers 5 3 3
Z Lift Distance 8 mm 4 mm 4 mm
Z Lift Speed 6 mm/s 15 mm/s 15 mm/s
Z Retract Speed 6 mm/s 15 mm/s 15 mm/s
Anti-alias 1
1.If the print object needs high accuracy, please use
group ® and modify the anti-alias level as 16 and the
image blur as 3.
2. The group @® apply to the model whose hollowed
thickness is no more than 2mm.
3. The group @® can significantly increase the print
Notice speed by cases test. To ensure the print success and print
speed, do not modify the parameters casually.
4. The group @® must work with the ACF release film
this printer provided to avoid print failure. The film can
be used to print 45000 layers.
5. The group ® only apply to Anycubic high speed resin.
6. Refer to 17-18 pages for the instructions of parameter
groups.

--The data above root in Anycubic lab, only for reference.



Menu Directory

Note: The current interface is for reference only. Please refer to the latest
firmware for accurate information.

Home menu

1.Temperature control resin vat
2.Statistic of print layers
Photon Mono M7 Pro 3.Statistic of circulation time
4.Resin bottle connection

w— 7 G i

Resin temperature
J2c 7 e

Print

Print:
Switch to local/ USB

drive/cloud file list guuese————
%K ik ik Click to enter into file details;
Y Y Y long press to edit the files.

TESTT TEST2 TEST 3 |
© 2405 © 02:20:45 €240 © 02:20:45 © 2409 ©02:20:45

I A &

TESTZ TESTS' TESTS

History

File Details:

Print file information

Detailed information

2500

200ml
ime  5h12min

Print function setting

History:

Print history,
Long press to edit

2023/09/19

2023/09/19

2023/09/19

2023/09/19
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Menu Directory

Tools

Z-axis:

10mm 50mm

Move the Z axis upwards

Z-axis zero point

Move the Z axis downwards Leveling test

Exposure:

10s | 20s 30s 40s 50s
Clear up:
Other:

Temperature control
resin vat

o
Feed and Retrieval PUSIEEERD e

Circulation Cleaning »

11

Move Z by 0.1Tmm
/Tmm/10mm/50mm

Move to check the effect
of manual leveling
(see page 29-30)

Choose an image to expose

Set the exposure time

Temperature control resin vat



Menu Directory

Tools

Other- Temperature control resin vat:

Z-axis  Exposure

Temperature control

- >
resin vat

Feed and Retrieval
Air purifier

Self-check

Other- Feed and Retrieval:

Z-axis  Exposure

Temperature control
resin vat

Feed and Retrieval >
Air purifier >

Self-check

Other- Air Purifier:

Z-axis  Exposure

Temperature control
resin vat

Feed and Retrieval
Air purifier

Self-check

Clear up

Clear up

Clear up

Other

Auto Heating

* Temperature

Circulation Cleaning

Feed

Retrieval

Other

Air purifier

Start heating

>
35°C >

>

Start loading

Enable/disable the
connection of air purifier

i When you enable “Air Purifier” , the connection of auto-fill unit will be disabled.
| To use the auto-feeding and unloading functions, please turn off air purifier

connection first.

Other- Self-check:

Z-axis  Exposure  Clearup

Check whether
WIFI module is on

Temperature control N
resin vat

Feed and Retrieval
Air purifier

Self-check

12

Other

Force Detection

WiFi Module

Print Layer

Cycle time

Start force detection

NS — =



Menu Directory

Settings

Cloud: App connection
WIiFi connection status

App WI-FI Versions  System

WLAN Not connected % >

App connection

Anycubic App Not connected ® >

Printer’'s hotspot (which
Lol is hidden when the
. Scan code to install Anycubic App netWOrk IS ConnectEd)

Log in to the App and scan the R code to add the printer

Network:

WI-FI Versions System

WiFi connection

Anycubic >

Set server P
———————————— el Check printer’'s CN

10.2.32.104

4E-74-Da-0C-D3-F1 MAC

Version:

App WI-Fl  Versions  System

Sl System version
A p p li c a t i O n Ve rS i 0 n -

Local upgrade >

OTA upgrade [ >

System:

App WI-FI Versions System

o Pl Turn on/off the screen sound

Set the language

Language English >

Storage repair

Format

Guide

Device
- About

13



1. Unbox, and take out the machine and its accessories.

2. Install the screen protector.

@ | - ap

Peel off the protective film Peel off the film @ Align the locating holes
Clean the LCD screen

Squeeze out the air bubbles

Peel off the film @

3. Install the WiFi antenna.

4. Check the input mode of power voltage first. The one shown as “230” is
suitable for 200V-240V; and the other one shown as “115” is suitable for
100V-120V. Then, connect to the power adapter, flip the rocket switch to
ON position and hold down the start button for 2s.

Voltage switch is located on
the underside of printer

14
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PHOTON MONG

7

5. Set the system language and choose server location. Users in mainland
Chinese please select "China", users in other countries and regions please

select "Global". Then, complete the on-screen setup steps.

ease select the system language

(L1351
CCKMIA A3BIK

Frangais

BAE

Push the platform onto Tighten the knob
the platform carrier

7. Install the resin vat.

Put resin vat with its feet Tighten the two knobs
stuck in locating holes

15



8. Install the auto-fill unit (optional). Please remove the seal from the resin
bottle first, as any residual seal on the bottle mouth may cause poor air
tightness and affect the automatic feeding.

1kg
Use Anycubic 1kg Connect the two
resin bottle pipes to the cap part

Insert the wire into
the port on the back

Attention:

1. Itis suggested to use the resin with a viscosity below 2000pcs, and place the
resin bottle behind or on the right side of the printer.

2. Never vigorously shake or turn over the resin bottle when the cap partis
installed. If the inside of the cap is stained by resin, please immediately clean it
to avoid malfunction or damage to auto-fill unit.

3. The operating temperature for auto-fill unit is 10-40°C and the humidity range
is 20-80%. For optimal performance, do not exceed these limits. If using
Anycubic Bio Resin or Anycubic Rigid 100 Resin, the recommended ambient
temperature is over 25°C. Otherwise, the functions of auto-fill unit may fail.

_

_______________________________________________________________________________________

16



File Upload

USB

1. Use Anycubic Photon Workshop software to process the 3D model file.

The installer and instructions is saved in the USB drive.

2. When you set the parameters in Anycubic Photon Workshop, there are

three groups of parameter which can be apply to the print with different

needs.

Preset Printers Machine Resin

Anycubic Photon Mono M7 Pro

n | ‘ Edit Resin [ I R |
Name Resolution Exposure A il
DefaultResin_Normal  ([(XEme) ::m:,s
Default Resin_Fast [ 0:100mm | 2200
High Speed Resin [ 0:100mm | [ 1.4005

Choose the parameter group according to the personal requirement

@ Default Resin_Normal

Apply to the Anycubic resin with normal printing speed. If the print object
needs high accuracy, please modify the anti-alias level as 16 and the
image blur as 3.

@ Default Resin_Fast

Apply to the Anycubic resin with fast printing speed. The layer thickness is

0.1mm. Optimizing the Z-axis motion control increases the print speed.

17



File Upload

® High Speed Resin
Only apply to the Anycubic high speed resin with the fastest printing speed.
The layer thickness is 0.1mm. Optimizing the Z-axis motion control

increases the print speed.
Notice for parameter group@0®:
" 1. The parameters apply to the model whose hollowed thickness is no more than
- 2mm.
2. The parameters must work with the ACF release film this printer provided to

avoid print failure. The film can be used to print 45000 layers.

3. Save the sliced file to USB drive.

4. Then, insert the USB drive to the printer.

USB drive:

1. Itis recommended that use the USB drive we provide. If you are using your
own USB drive, please ensure that it is formatted to FAT/FAT 32 and has a

. memory size of less than 64G.

2. To ensure proper file reading, please put print files in the root directory of USB
. drive.

/
I
'

18



File Upload

Cloud

Please connect the printer to Anycubic App first for remote uploading and monitoring.

1. Connect to the network.

WI-Fl  Versions  System a & WI-Fl  Versions  System Versions  System

Not connected
v Anycubic

Anycubic App

WiFi 1

Printer hotspot

Scan code to install Anycubic App
Log in to the App and scan the QR code to add the printer

WiFi 2

WiFi 3

2. Please search "Anycubic” in App Store or Goolge Play, or scan the QR
code on the printer, to download Anycubic App. Then, sign up and sign in.

WI-Fl  Versions  System
Anycubic >

Anycubic App Not connected ® >

- ==\
sdan code to install Anycubic App
Lol in to the App and scan the QR code to add the printer
[

3. Add a printer in Anycubic App.

Workbench < Add printer

B File > O Task >

. WI-FI Versions  System

)

PHOTON MONO M7 (20

Anycubic >

mm ’ .
= B Please follow these steps to complete adding the printer
. ¥
1. Complete the assembly of the printer Anycubic App Not connected ® >
2. Turn on the printer switch and complete the
networking operation o=

3. Scan the QR code of the device CN —-——
- skan code to install Anycubic App
o Ldgin to the App and scan the QR code to add the printer
!

T

£ Device CN

@‘\ ‘ R Scan the QR code to
add printer

Help

Photon M3 Max FF R EHI5R a
©
Workbench

19



File Upload

4. Search model or upload the model files.

e Search model

Workbench

B Fie > O Task >

Printer

Anycubic Photon Mono M7 Pro
.

Total printing time: O hour 0 min
Total consumption Resin: Oml

Printer type: Anycubic Photon Mono M7 Pro

model recommendation CChange

Ha:

Cobb Vanth

Batman on a roof CATBUS(MY NELI...
Early summer Early summer Early sum
Help More >
©
Workbench

* Upload the model files

Workbench

B i > O Task >

Printer

Anycubic Photon Mono M7 Pro
.

Total printing time: O hour 0 min
Total consumption Resin: Om|
Printer type: Anycubic Photon Mono M7 Pro

model recommendation CChange

Batman on a roof CATBUS(MY NEL... Cobb Vanth

Early summer Early summer Early sum|

More >

Help

© ®

Workbench

Search model

than 1 million printable

# Popular searches: ~ alien  flexi  harry potter

deadoralive  onimask terminator v

Recommend Sliced Newbie zone

tortoise Free 3D print
model
Cytrader Thangs

Gridfinity Pick + Tweezer
Racks

Ironman helmet with Succubus
opening mechanism Thangs

Search model

< File Space use0.008/2.00GB &

There are currently no printable files, Please upload model or
slice files

printer model recommendation C Change
b Batman on a roof
® «le white
B CATBUS(MY NEIGHBOR TOTORO)

Daniel Toledo

Jnusiliag  Cobb Vanth from Star Wars the

Vkmﬁ Mandalorian

- o @ Harryolvera

Chained One

@ Harry Olvera

20



Print Test

Resin Preparations

*The release film on the resin vat is consumable. Please pay attention to the
status of release film on the touch screen and replace the film timely.

Please check the release film carefully before and after every printing. If the film
is broken, replace it immediately to avoid further damage to the machine.

1. Make sure to wear a mask and gloves (to avoid direct skin contact with
the resin), slowly pour resin into the vat, and make sure it is within the vat’s
maximum scale.

sy Dl

]

2. Enable the automatic feeding (optional). Please install the auto-fill unit

before using.

. TIPS: When using resin with a viscosity over 500cps at room temperature (25°C),
the resin bottle may experience slight deflation or inflation due to pressure

changes. This is normal and does not affect loading and unloading.

21



Print Test

3. When the ambient temperature is below 20 °C, it may cause the
detachment of printed bottom or partial loss of printed objects. You can

enhance the printing effect by enabling preprint heating.

Enable preprint heating. The printing starts when the resin temperature
reaches 25 °C.

. Attention:

1. Material circulation is enabled by default during heating process.
2. When the resin vat heats up for a long time, its surface temperature becomes
high. Avoid touching the resin vat without protection after heating.

4. Put on the cover.

22



Print Test

Print File

Print USB drive file

Storage (\ Cloud History Storage Cloud History
TES TESTZ TESTS
© 2009 0220:45)  © 2405 ©022045 @ 2405 © 022045

L &

TEST® TESTS TESTS

Detailed information

Layers 2500

Layer Thickness ~ 0.05mm
@ Resin 200ml
© Estimated Time ~ 5h12min
W Speed Mode Normal

Print Function

Remote print

Workbench < Print Online slicing

Cloud Local
B File > O Task >

Printer: Anycubic Photon Mono M7 Pro

Printer More > TEST .stl

Type: model file

% Size: 54.35MB
&

Anycubic Photon Mono M7 Pro 2022-03-25 10:00:00

@ Prig
Total printing time: O hour 0 min :
Total consumption Resin: Oml
Printer type: Anycubic Photon Mono M7 Pro

TEST stl
o Type: model file
model recommendation CChange % Size: 54.35MB
o 2022-03-25 10:00:00

@ Print

o e L & 111722
Batman on a roof CATBUS(MY NEL..  Cobb Vanth [ Anyoubic Photon Mono
Early summer Early summer Early sum|
Slicing template
Help More >

High speed

®

Workbench

23



Print Test

Before printing

1. Before printing, the printer checks the hardware condition, resin volume
and residue before each print job. When there is an error, the printer will

pop up the error QR code. Please scan the code and follow the guide.

Platform Detection

Before printing, check whether the print platform is installed.

Residue Detection

Before printing, check if there are the solid residues* in the resin vat. If residues
are detected, please clean the vat and check again.

*solid residue: height=3mm, cross section=9mm?

Resin Detection

Before printing, check whether the resin in the vat is sufficient to finish the print
job. Usually, the required volume is a little more than the volume estimated by
the slice software.

If the auto-feeding is enabled, the equipment will automatically replenish the

resin when it detects the resin insufficiency.

2. If the in the bottle is insufficient, the printer will pop up warning. Please
refill or replace the resin bottle timely.

\ @

Low resin in the bottle poses
aresin shortage risk;

kindly replenish the resin.

1kg Cﬁ“\

3. The feeding before printing can be skipped. If skipped at this time, it will

not occur during printing.

4. You can choose to skip heating if necessary. Please be cautious, as low

ambient temperature and insufficient heating time may lead to print failure.

24



Print Test

In Printing

Failure detection: During printing, the printer automatically monitors the
conditions which may cause print failure to avoid wasting resin or
damaging to the printer. When the printer detects an abnormal condition, it
will pause the print job automatically and pop up the error report. Please
check the sliced file and the model according to the report. The failure

detection is enabled by default.

Bottom non-stick detection

It checks whether the model sticks to the print platform.

When the printer detects that the model does not stick the platform, please
check the bottom exposure time of the sliced file.

Off compensation: When the exposure area is large during printing, due to
the surface tension and the resin characteristic, there may be problems
such as delay of Z-axis or delay of resin reflowing, resulting print failure.

The function is enabled by default.

Intelligent release: The function can improve the printing success rate by
optimizing algorithm. Enabling intelligent release while printing with the
default resin_normal parameter group can also increase printing speed.

The function is disabled by default.

Before printing, the functions can be enabled/disabled in the print function

interface.

25



Print Test

After Printing

1. After printing, remove the platform when resin stop dropping from the
platform. Remove the model by metal scraper and then wash it with 95%
alcohol or other detergent. After cleaning and drying, proceed with post-

curing and any other necessary post processing of the model.

2. After printing, click “Unload” to recycle the resin. Use a plastic scraper
to guide resin to the output of the auto-fill unit, facilitating the unloading
process. However, if the printing fails, do not enable the unloading
function to prevent the auto-fill unit from blocking or being damaged.

3. When the printing fails, resin may be cured partially in the vat. Please set
to Cleaning and remove the residue. Otherwise, it may cause damage to

the release film or LCD screen.

o Z-axis  Exposure
N —

0.1mm ‘ 1mm

T

-
Use a plastic spatula to lift the residue from the box

(o]

Remove resin sheet
by plastic scraper

4. Please pour out the remaining resin through a front spout of the vat, and
filter it by a funnel. Do not pour out the resin through the back side of the

vat to avoid the damage to the resin vat.

Vat spout ----- .=



Resin Exposure Range Finder

“R_E_R_F"” is an abbreviation for “Resin Exposure Range Finder” . This function

is used to find out the optimal exposure parameters for different resins.

1. Import the R_E_R_F file which is saved on USB drive into the slicing
software. There are eight models in the file. The exposure time for model 1
is equal to "normal exposure time (s)" of the file, and the exposure time for
other models will be increased by an increment of 0.25 s.

For example:

WACNBIC

=2
A,
g oo
=

The numbers on the models indicate the order

2. According to the personal requirement, adjust the exposure time of the
models by modifying "normal exposure time (s)“ of the file. When
exposure time for Model No. 1 is changed, the exposure time for other

models will be increased by an increment of 0.25 s.

For example, when normal exposure time is set to 1.5 s, the exposure time
for Model No.1-81is:1.5/1.75/2/2.25/2.5/2.75/ 3/ 3.25 s.

3. After printing, remove and clean the models. Compare the print effect of
models and choose the model’s exposure time that meets your needs as

the print parameter. Take a comparison of model A&B as an example.

27



Resin Exposure Range Finder

Less cylinder More cylinder

« Model A has more holes and fewer cylinder. If you print by the parameter
of model A, more details of model can be printed with high risk of failure.
« Model B has fewer holes and more cylinder. If you print by the parameter

of model B, model may be printed successfully yet with some details lost.

In addition, you can compare the bridges, needles or other parts to choose
a proper model and find the parameter. If none of them can be chose,

adjusting the "normal exposure time (s) “ is suggested.
Notice: DO NOT change the file name of “R_E_R_F”, because Anycubic 3D printer

can only recognize THIS file name to run this function. Also, do not name other
fileas "R_E R F".

28



Maintenance

Leveling

The printer has been designed requiring no
leveling for the first use. However, please re-
level the printer in the following scenarios:

* The print platform has been fallen to the

ground.
Scan the QR code for

» Changing new print platform or LCD screen. _ _
the leveling tutorial

* The printed object sticks to the resin vat

instead of the print platform.

Please follow the steps below to install and re-level.

1. Install the print platform.

Loosen the four Push the platform onto Tighten the knob
leveling screws the platform carrier

2. Leveling.

Tmm 10mm 50mm 1mm 10mm 50mm

{ERR oETEss
Leveling Paper

=
m

Place the leveling Click “Z-axis Home" Lower Z axis by Tmm
paper (included)
on the LCD screen

29



Maintenance

I
| ity

If the print platform Lower until there is resistance

shakes with light press, when pulling out the leveling
lower Z axis by paper, hold the platform and
0.1mm each time tighten the four screws

3. Check whether the leveling is successful. If it does not match the result

shown below, please loosen the four leveling screws and follow the step2

to re-level.

Click “Check Leveling” When you pull the
leveling paper, thereis a
significant resistance or

it cannot be pulled out

30



Maintenance

Resin Vat Maintenance
* Remove the cured resin from release film: Set Cleaning and then
remove the cured resin sheet to protect the film. Do not use sharp objects

to scrape off the residues from the film.

Z-axis  Exposure (\ Other
0.1mm 1mm 10m 50mm — )

Use a plastic spatula to lift the residue from the box

Remove resin sheet

by plastic scraper

* Remove the liquid resin from resin vat: If there is only liquid resin in the
vat, pour out the resin and then follow the steps of circulation cleaning to

clean the vat.

Z-axis zero point

Leveling test

* Release film replacement: The statistics of print layers are shown in
Home menu. Please check them and replace release film timely to avoid

print failure or even the damage to printer.

Photon Mono M7 Pro Photon Mono M7 Pro

Component status

“ Connected

Component status

“ Connected

45000 e

Need to replace Click reset button
release film after replacement

» If you do not use the resin for over 48H, store it in an airtight container

away from light.
« If resin is stained on the resin vat, wipe it off timely. Never immerse the

Temperature control resin vat in water, alcohol or other cleaning solvent

to avoid the damage.
» Itis suggested to use non-flexible resin with a viscosity below 1000 cps.

31



Maintenance

Replace Peristaltic Pump Pipe
Please replace the peristaltic pump pipe when the circulation time reaches
100%, as shown on the Home menu.

1. Put on gloves.

2. Remove the used peristaltic pump pipe.

] e

Cut off two zip ties

Remove the pump pipe

3. Install a new peristaltic pump pipe.

Insert a new pump pipe Secure the bottom of Grease the pipe and shaft
pipe with 2 zip ties

Put on the front cover Tighten 2 screws on the back Reset the circulation time

Please fully insert the new pump pipe to the bottom to ensure proper installation.

32



Maintenance

Firmware Upgrade
» USB upgrade: Visit the official website to download the firmware and
save it onto a USB drive that doesn’t have any other version of firmware.

Then, insert the USB drive to printer to upgrade.

* OTA upgrade: If the network is connected, directly upgrade by OTA.

App WI-FI VE(!\ stem
M Not connected ® >
lot connected ® >

Z-axis Maintenance

If Z axis makes a noisy sound, please apply lubricant to Z lead screw.

Cleaning

* Clean the print platform: Clean platform with alcohol and paper towel.
* Protect LCD screen: If there is resin being cured on the screen protector,
please replace the protector immediately.

* Clean the body of printer: Clean the body of the printer with alcohol.

33



Complete the initial trouble shooting steps by referring to the following proposed

solutions, or contact our technical support for additional assistance.

Print

1.

Model do not stick to platform
Bottom exposure time is insufficient. Please increase the exposure time.

Contact area between the model and platform is small. Please add a raft.

. Layer separation or splitting

The machine is not stable during printing.

The release film is not tight enough or needs a replacement.
The printing platform or resin vat is not tightened.

The lift speed is too fast.

The model is hollowed without punching.

. Layer shift

Add supports.
Reduce the lift speed.

. Floccules left in resin vat or attached to models

The exposure time is too long. Reduce the normal exposure time and

bottom exposure time.

Cloud connection

1. WIFI connection is failed

WiFi name or password is wrong. Please reset the network and reconnect.

The WiFi network is unavailable. Join an available network. Then, reset

the network and reconnect.

2. Fail to add printer in App

Check “Server Location” . Users in mainland Chinese please select

"China", users in other countries and regions please select "Global".
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Complete the initial trouble shooting steps by referring to the following proposed

solutions, or contact our technical support for additional assistance.

Auto feeding & Unloading

1. The printer prompts that resin in the vat is not enough before printing.

» The auto-fill unit has a poor connection to the printer. Please reinstall the
auto-fill unit and then click “OK" .

« The auto-fill unit has been malfunctioned because resin entered in the
air pipe.

2. The resin in the bottle is sufficient, but the printer prompts no resin in

the bottle.

« The cap part has a poor connection to the printer. Please reinsert the cap

part wire.

3. The resin liquid level reaches the needles of the auto-fill unit. However,
when you click “unload”, the printer immediately prompts that
unloading completes.

« The thumb screws securing the resin vat are not tightened. Please stop

unloading and tighten the thumb screws.

4. The green light of auto-fill unit is off and load, unload as well as auto-
feed option is invalid.
« Check whether the air purifier connection is enabled. Enter into “Tools” -

“Other” - "“Air Purifier” , and disable “connect to air purifier” .

Thank you for purchasing Anycubic products! Under normal usage and
service, the products have a warranty period of up to one year. Please visit
Anycubic support center(support.anycubic.com/en) to report any issues
with Anycubic products. Our professional after-sale service team would
respond within 24 hours and solve the issues.
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